Note:
To change the product logo for your own print manual or PDF, click "Tools > Manual Designer" and modify the print manual template.
This is "Title Page 1" - you may use this page to introduce your product, show title, author, copyright, company logos, etc.

This page intentionally starts on an odd page, so that it is on the right half of an open book from the reader's point of view. This is the reason why the previous page was blank (the previous page is the back side of the cover).
TSC Free Address Book

© 1994 - 2011 by TurboSystemsCo, LLC

All rights reserved. No parts of this work may be reproduced in any form or by any means - graphic, electronic, or mechanical, including photocopying, recording, taping, or information storage and retrieval systems - without the written permission of the publisher.

Products that are referred to in this document may be either trademarks and/or registered trademarks of the respective owners. The publisher and the author make no claim to these trademarks.

While every precaution has been taken in the preparation of this document, the publisher and the author assume no responsibility for errors or omissions, or for damages resulting from the use of information contained in this document or from the use of programs and source code that may accompany it. In no event shall the publisher and the author be liable for any loss of profit or any other commercial damage caused or alleged to have been caused directly or indirectly by this document.

Printed: February 2011 in (wherever you are located)

Special thanks to:

All the people who contributed to this document, to mum and dad and grandpa, to my sisters and brothers and mothers in law, to our secretary Kathrin, to the graphic artist who created this great product logo on the cover page (sorry, don't remember your name at the moment but you did a great work), to the pizza service down the street (your daily Capricciosas saved our lives), to the copy shop where this document will be duplicated, and and and...

Last not least, we want to thank EC Software who wrote this great help tool called HELP & MANUAL which printed this document.
# Table of Contents

**Foreword** 7

**Part I Introduction** 9

**Part II Licensing and Purchase** 11

1. License ........................................................................................................... 11
2. Support ........................................................................................................... 12

**Part III Getting Started with TSC Free Address Book** 14

1. Program Navigation ........................................................................................ 14
   - Menu ........................................................................................................... 14
   - Tool Bar ..................................................................................................... 16
2. Address Databases .......................................................................................... 17
   - Creating a New Address Database .................................................................. 17
   - Open an Existing Address Database .............................................................. 17
3. Addresses ......................................................................................................... 17
   - About Addresses ......................................................................................... 17
   - Adding a New Address ............................................................................... 18
   - Editing an Existing Address ......................................................................... 22
   - Deleting an Address ..................................................................................... 24
   - Copy an Address ......................................................................................... 25
   - Finding an Address ..................................................................................... 25
   - People Listing ............................................................................................... 26
   - Mailing Lists ................................................................................................. 27
     - Selection Criteria Window ........................................................................... 29
     - Selection Results ......................................................................................... 30
   - Keywords ....................................................................................................... 31
     - Keyword List ............................................................................................... 31
     - Keyword Form ............................................................................................. 31
     - Select a Person ............................................................................................ 32
   - Name Prefix List ............................................................................................ 33
   - Name Suffix List ............................................................................................. 33
   - State List ........................................................................................................ 33
   - Language List ................................................................................................. 33
   - Country List ................................................................................................... 33
4. Performing Actions on Addresses .................................................................. 34
   - Sending Email ............................................................................................... 34
   - Get Driving Directions and Map ................................................................... 34
   - Get Address Information .............................................................................. 34
   - Visit a Web Site ............................................................................................. 34
5. Letters .............................................................................................................. 35
   - About Letters ............................................................................................... 35
     - Add a New Letter ...................................................................................... 36
     - Add a New Category .................................................................................... 37
6. Print ................................................................................................................. 37
   - Summary Reports .......................................................................................... 40

© 1994 - 2011 by TurboSystemsCo, LLC
Foreword

This is just another title page placed between table of contents and topics
Top Level Intro

This page is printed before a new top-level chapter starts
1 Introduction

Welcome to TSC Free Address Book. TSC Free Address Book is an easy to use program to keep track of your contacts and print letters, labels and lists. The program allows you to create an unlimited number of letters using the built-in letter writer that includes spell checking. With this program you can assign your contacts to one or more lists, such as a Christmas Card or Club List. You can print letters (with address merge) or labels to an individual, to all members of a list or to everyone in the database. You can print letters in multiple languages. The program can decide which language to use for each person. Using the easy to use query wizard you can filter individual list or databases to print to exactly the individuals you want. You can mark a contact as active or inactive for any mailing list. You can then choose to mail to only active, inactive or both members of a list depending upon your needs. You can use a user defined keyword list to define a list of criteria (i.e. products, interests, customer types, etc.) that can be assigned to individuals. More than one keyword can be assigned to an individual for flexibility. Use the list building utility which allows an entire mailing list to be created quickly. Simply fill in criteria to select a unique group of people (i.e. by keywords, state, birthday) and check the results. Add on to existing list one person at a time, or add a group of people with the list building utility. You can also create an unlimited number of databases. The last used database will be automatically opened when you start the program. With the letter writer you can create letters in multiple languages and the correct language letter will be printed based on the contacts language stored in the database.

Quickly get driving directions to any address in your database. Press the Address Info button and get detailed information about and address such as latitude, longitude, time zone, Congressional Representative, census tract, census block, county, school district, delivery post office and much more. Dial a contacts number or send them an email with the touch of a button. Print letters, labels or listings to the screen for preview, printer, PDF, text, XML or HTML that can be posted on the web.

You can import data into the system from data stored in dBase, ASCII comma delimited or Excel format. You can also export your data in dBase, ASCII delimited, ASCII flat file, Excel and HTML formats. The program has a zip compatible backup and restore module to protect your data.
Top Level Intro

This page is printed before a new top-level chapter starts
2 Licensing and Purchase

2.1 License

TSC Free Address Book is distributed as FREEWARE: permission is granted to anyone to use this software free of charge. TurboSystemsCo, LLC will charge a $12 shipping/handling fee if you wish to received a copy of this program on CD by USPS First Class Mail.

The use of this package indicates your understanding and acceptance of the following terms and conditions. This license shall supersede any verbal or prior verbal or written, statement or agreement to the contrary. If you do not understand or accept these terms, or your local regulations prohibit license agreements or limited disclaimers, you must cease and desist using this product immediately. This software and the accompanying documentation are protected by the copyright law of the United States and by international treaty provisions. It may not be reproduced in any form save for the sole purpose of making archival (backup) copies to protect your investment.

Distribution

Anyone is allowed to distribute TSC Free Address Book without fee. Make sure all original files are included and that they are unchanged. If you want to include of TSC Free Address Book on a shareware/freeware CD, upload to an Internet server or publishing screenshots in the press, you can do this without any charges or royalties. However you can not charge anyone fee for TSC Free Address Book with written permission of TurboSystemsCo, LLC.

Restrictions

You may not reverse engineer, decompile, or disassemble TSC Free Address Book under any circumstances.

You may not rent or lease TSC Free Address Book without permission of TurboSystemsCo, LLC.

Disclaimer of Warranty

THIS SOFTWARE AND THE ACCOMPANYING FILES ARE PROVIDED "AS IS" AND WITHOUT WARRANTIES AS TO PERFORMANCE OF MERCHANTABILITY OR ANY OTHER WARRANTIES WHETHER EXPRESSED OR IMPLIED. Because of the various hardware and software environments into which TSC Free Address Book may be put, NO WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE IS OFFERED.

Good data processing procedure dictates that any program be thoroughly tested with non-critical data before relying on it. The user must assume the entire risk of using the program.
TurboSystemsCo, LLC assumes no responsibility for loss of data or any other losses that may occur as a result of using the product supplied TurboSystemsCo, LLC specifically disclaims all other warranties, expressed or implied, including but not limited to any implied warranty of merchantability or fitness for a particular purpose.

**General**

1. If any provision in this License and Limited Warranty is found invalid or unenforceable, it will not affect the validity of the balance of this agreement, which shall remain valid and enforceable according to its terms.

2. The License and Limited Warranty may only be modified in writing signed by the Licensee and a specifically authorized representative of TurboSystemsCo, LLC.

3. All rights not specifically granted in this License and Limited Warranty are reserved by TurboSystemsCo, LLC.

Copyright © 1994 - 2011 by TurboSystemsCo, LLC and Lemuel D. Turner. All Rights Reserved Worldwide

### 2.2 Support

Because this license is granted to the user for no cost, free technical support is not provided by TurboSystemsCo, LLC. If required we can provide technical support on a per incident basis with a minimum charge of $15.00
Top Level Intro

This page is printed before a new top-level chapter starts

Part

III
Getting Started with TSC Free Address Book

Welcome to TSC Free Address Book. TSC Free Address Book is an easy to use program to keep track of your contacts and print letters, labels and lists. The program allows you to create an unlimited number of letters using the built-in letter writer that includes spell checking. With this program you can assign your contacts to one or more lists, such as a Christmas Card or Club List. You can create an unlimited number of list with TSC Free Address Book. You can print letters or labels to an individual, to all members of a list or to everyone in the database. Using the easy to use query wizard you can filter individual list or databases to print to exactly the individuals you want. You can mark a contact as active or inactive for any mailing list. You can then choose to mail to only active, inactive or both members of a list depending upon your needs. You can use a user defined keyword list to define a list of criteria (i.e. products, interests, customer types, etc.) that can be assigned to individuals. More than one keyword can be assigned to an individual for flexibility. Use the list building utility which allows an entire mailing list to be created quickly. Simply fill in criteria to select a unique group of people (i.e. by keywords, state, birthday) and check the results. Add on to existing list one person at a time, or add a group of people with the list building utility. You can also create an unlimited number of databases. With the list writer you can create letters in multiple languages and the correct language letter will be printed based on the contacts language stored in the database.

Quickly get driving directions to any address in your database. Press the Address Info button and get detailed information about and address such as latitude, longitude, time zone, Congressional Representative, census tract, census block, county, school district, delivery post office and much more. Email a contact with the touch of a button. Print letters, labels or listings to the screen for preview, printer, PDF, text, XML or HTML that can be posted on the web.

You can import data into the system from data stored in dBase, ASCII comma delimited or Excel format. You can also export your data in dBase, ASCII delimited, ASCII flat file, Excel and HTML formats. The program has a zip compatible backup and restore module to protect your data.

The program stores an unlimited number of contacts.

3.1 Program Navigation

3.1.1 Main Menu

Program items can be selected from the pull down menu across the top of the screen or from the Tool Bar.

<table>
<thead>
<tr>
<th>File</th>
<th>Edit</th>
<th>List</th>
<th>Print</th>
<th>Online</th>
<th>Explore</th>
<th>Window</th>
<th>Help</th>
</tr>
</thead>
</table>

File Menu

New Database Use this option to create a new database
Open Database Use this option to open an existing database

File Maintenance The file maintenance screen provides basic file maintenance for your data. You probably will never need to use any of the procedures.

Export Data Displays the export window. Can Export data in dBaseIII, dBaseIV, ASCII, Excel and HTML

Import Data Displays the import window. Can import data in Excel, dBase and ASCII format.

Print Setup Sets the default printer

Backup - Restore Backup and/or Restore your data

Exit

List Menu

List of People Displays the People List window. From the list new people can be added, edited, deleted, sorted and more.

List of Mailing Lists Displays the Mailing List window. From there new mailing list can be created, edited or deleted

List of Key Words Displays the Key Words window. From there key words can be added, edited, or deleted

List of States Displays the States List window. From there new states/provinces can be added, edited or deleted.

List of Name Prefixes Displays the Name Prefix window. From there name prefixes can be added, edited, or deleted

List of Name Suffixes Display the Name Suffixes window. From there name suffixes can be added, edited, or deleted

List of Languages Display the Language List window. From there Languages can be added, edited, or deleted

List of Countries Display the Country List window. From there Countries can be added, edited, or deleted

List of Letters Display the Letters List window. From there name Letters can be added, edited, or deleted

List of Categories Display the Categories List window. From there Categories can be added, edited, or deleted

Label Definitions Display the Label Definitions window. From there labels can be added, edited, or deleted

List of Users Display the Users List window. From there Users can be added, edited, or deleted
Print Menu

Summary Reports
People by State/City
Creates a report of all people sorted by State and City.

People by Alphabetical Order
Creates a report of all people ordered alphabetically.

People by Keyword
Creates a report of all available keywords and those people who are associated with that keyword.

Mailing List Summary
Creates a report of all the mailing list including mailing list name, description and the people on each list.

Labels
Labels by List
Allow you to print labels for members of a particular list, for example birthday list.

Labels to All
Prints labels for all people in the database.

Labels by Individual
Print labels for one individual.

Letters
Letters by List
Allows you to print letters to members of a particular list, for example birthday list.

Letters to All
Prints letters for all people in the database.

Letters by Individual
Print letters for one individual.

Explore

View Main Data Folder Displays the files that contain the people list, mailers list keywords, etc

View System Data Folder Displays the files that contain lookup information such as state names, name prefixes etc.

3.1.2 Tool Bar

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="People Icon" /></td>
<td>Browse the people file. From here you can add, edit or delete people and their contact information</td>
</tr>
<tr>
<td><img src="image" alt="List Icon" /></td>
<td>Browse the mailing list file. From here you can add, edit or delete mailing list</td>
</tr>
<tr>
<td><img src="image" alt="Letters Icon" /></td>
<td>Browse the letters file. From here you can add, edit or delete letters</td>
</tr>
</tbody>
</table>

© 1994 - 2011 by TurboSystemsCo, LLC
3.2 Address Databases

A collection of contacts are stored in and address database. You can store and unlimited number of contacts and addresses in an address database.

You can create an unlimited number of address databases.

3.2.1 Creating a New Address Database

To create a new address database select File>New Database from the main menu.

On the Add a New Database Screen enter a Name, such as MyMailList, ClubList, etc. DO NOT enter any drive or path information, just a name for the database only. You can also enter information in the comment field.

Your old database will close and a new empty database will open, when you press the OK button.

3.2.2 Open an Existing Address Database

To open an existing Address Database select File>Open Database highlight and existing database and double click or click the Select button to open an existing Address Database

3.3 Addresses

3.3.1 About Addresses

An address is all of the information associated with a single contact. This includes their name, title, organization, telephone numbers, mailing addresses, e-mail addresses, language, date of birth etc.

Addresses are displayed in the People Listing. If the People Listing is not displayed on the screen, click on the person icon on the toolbar or select List>List of People from the main menu. Each address is displayed in a single row in the People List. You can filter the which addresses are displayed based on name by using the Alphabet Bar. You can also sort the address list by name, city/state or organization by clicking on the Name, City/State or Organization Tabs at the top of the People Listing.

Actions can be performed on an a selected address such as sending an email, getting a map to an address, finding census information about an address or visiting a web page.
See Also

Adding a New Address
Editing an Address
Deleting an Address
Editing an Address
Copying an Address
Finding an Address
Importing and Exporting Addresses
Keywords
People List
Mailing Lists
Name Prefix List
Name Suffix List
State List
Country List
Language List

3.3.2 Adding a New Address

To add a new address click the Add Button on the People Listing or press the Insert key on the keyboard. Alternatively using the mouse, right click on the People Listing and select Add from the pop-up menu. The address editor dialog will be displayed where you can enter the information about the new address.
Person Profile Tab

The name section has five parts: salutation, first name, middle initial, last name, and name suffix. All the entries will have the first letter of the word capitalized automatically.

This field is a drop down pick list. Select an item from the drop down list. A blank is allowed in this field. You can add a new item if needed.

This field is optional. The first letter of each word is capitalized.

This field is optional. If a letter is entered, the letter is capitalized.

This field is required. The first letter of each word is capitalized.
This field is a drop down pick list. Select an item from the drop down list. A blank is allowed in this field. You can add a new item if needed.

This field is optional. Enter a person's title such as President, CEO etc.

This field is optional. Holds the name of the company or organization the person belongs to.

This field is optional. It contains the street number and name.

This field is optional for more address information such as a suite # or mailstop

This field is optional

This field is required. Values entered in this field are validated against the state listing. If an entry is not valid the state list will be shown for choosing a valid state.

This field is required. It will accept the five digit or the five digit +4 format for US postal codes or Canadian/European postal codes.

This field is a drop down pick list that defaults to United States

This field is optional. Enter the persons home phone number. No automatic formatting is performed on the number

This field is optional. Enter the persons work phone number and extension if applicable. No formatting is performed on the number

This field is optional. Enter the persons fax phone number. No formatting is performed on the number

This field is optional. Enter the persons email address.

This field is optional. Enter the address to the persons web site.

This field is optional. Enter the format as MM/DD/YYYY. The date can optionally be
rt selected from the calendar lookup button.
date
The current age of the person is displayed in years and months.

text
Age
This field is optional. It defaults to English.

text
Age
This field is optional. Choose one of the two radio button selections.

Key
This list displays keywords associated with this person. New keywords can be added to your list and existing keywords can be removed from the list.
or
dS
Add This button calls a pick list of keywords to be added to the keyword list box.
d
key
yw
or
d
Delete This button will delete the highlighted keyword from the list associated with this person. It does not delete the keyword from the file, only their reference to this person.

Note
This field is optional. Used for recording any additional information about this person.

tes The box is scrollable.

Mailing List Tab

Mailing This list displays the mailing lists (categories) to which this person is currently a member. New mailing categories can be added to this list and existing mailers can be removed from the list.

Add Button This button calls a pick list of mailers (categories) to add to the mail list list box.

Modify Button This button calls the form to update the status of the highlighted mail list. This form changes the status of the mailer for this person only.

Delete Button This button will delete the highlighted mailer from the list associated with this person.

It does not delete the mail list from the file, only their reference to this person.
See Also

About Addresses
Editing an Address
Deleting an Address
Copying an Address
Finding an Address
Importing and Exporting Addresses
People List
Keywords
Mailing Lists
Name Prefix List
Name Suffix List
State List
Country List
Language List

3.3.3 Editing an Existing Address

To modify an existing address select the address in the People List, then press the Edit button. As a shortcut, you can also just press the Enter key on your keyboard or left double click with the mouse when an address is highlighted. The address editor dialog will be displayed, where you can view or modify the information for this address. This window displays the profile information for one person. This profile information includes address information, keyword groupings, and membership to individual mail lists. Using the scroll controls on the bottom of the screen, the people can be scrolled through one record at a time.
**Button** | **Description**
---|---
**Email** | This button will be enabled if the person has an email address. Pressing the button will open your default email system with the person email address end the send to field.
**Web** | This button will be enabled if the person has a web address listed. Pressing the button will take you to the listed web site.
**Mapquest** | Activates your web browser and displays a map of the address where you can obtain driving directions to the address.
**Address Info** | Activates your web browser and provide you with the following information about the address if available such as Zip+4, latitude longitude time zone, Congressional Representative, Census tract, Census block, County, School District, Delivery Post Office, and much more.
**ABC** | Activates the spell checker and spell checks the notes field.
**Help** | Displays this screen.
**OK** | Closes the window and saves any changes made.
**Cancel** | Closes the window without saving changes.
See Also

- About Addresses
- Adding a New Address
- Deleting an Address
- Copying an Address
- Finding an Address
- Importing and Exporting Addresses
- People List
- Keywords
- Mailing Lists
- Name Prefix List
- Name Suffix List
- State List
- Country List
- Language List

### 3.3.4 Deleting an Address

To delete an existing address select the address in the People List, highlight an address. Then press the **Delete** button. As a shortcut, you can also just press the Delete key on your keyboard or right click on the mouse and select Delete from the pop-up menu.

See Also

- About Addresses
- Adding a New Address
- Editing an Address
- Copying an Address
- Finding an Address
- Importing and Exporting Addresses
- People List
- Keywords
- Mailing Lists
- Name Prefix List
- Name Suffix List
- State List
3.3.5 Copy an Address

If you are entering a new address where most of the information is the same as and existing address, highlight the existing address and click the Copy button. Edit the data in the address editor dialog, make changes as needed and save as a new address record.

See Also

About Addresses
Adding a New Address
Editing an Address
Deleting an Address
Finding an Address
Importing and Exporting Addresses
Keywords
People List
Mailing Lists
Name Prefix List
Name Suffix List
State List
Country List
Language List

3.3.6 Finding an Address

There are three ways to search for records. Quick search, Find Dialog and Query Wizard.

Quick Search

You can search for a record by last name, state or organization. To conduct a quick search by last name, click Name Tab. To search by state, click the State/City Tab, To search by Organization click the Organization Tab. Once you click the appropriate tab, just begin typing at the keyboard and the record that matches will be selected.

Find Dialog

You can search by full name, state/city or organization. Select the appropriate tab, then enter the information in the lookup field at the bottom of the screen and press the tab key. The screen will locate the item that matches or the nearest match to the information typed.
Query Wizard
The query wizard allows you to search the database on multiple fields using comparison operators such as equal to, less than, greater than, begins with, contains etc. See Query Wizard section for more additional information.

3.3.7 People Listing
The People Listing is the heart of the program and is used to add, delete, edit and find people/addresses and much more. This screen can be accessed by selecting List> List of People or by clicking the icon on the tool bar.

See Also
- Adding a New Address
- Editing an Existing Address
- Deleting an Address
- Copy an Address
- Find an Address
- Sending an Email

© 1994 - 2011 by TurboSystemsCo, LLC
3.3.8 Mailing Lists

Addresses can be assigned to one or more mailing lists (categories). You can create an unlimited number of mailing lists. Addresses may be assigned to one or more mailing list. You can add a new mailing list category by selecting the following from the main menu:

List> List of Mailing Lists

To add a new Mailing List Category, click the Add button on the Mailer List Screen. Enter the Mailing List Category name in the Description field. You can also enter notes about the Mailing List Category in the Mailer Notes field. See Below.
There are two ways you can assign a person to a mailing list category, individual or multiple.

Add an Individual to a Mailing List Category

1. Click the Insert button which displays the select a person screen
2. Highlight the person you want to add to a mailing list.
3. Click the select button or double click on the highlighted person
4. The person will be added to the category
5. Repeat steps 1 - 3 to add and additional people to the category.

Add multiple Individuals using the Build List Feature

1. From the main menu select File> List of Mailing Categories
2. Click the Add button to add individuals to a new list or the Edit button to add individuals to an existing list.
3. Enter a name in the Description field if it a new Category List.
4. Optionally enter notes in the Mailing Notes field.
5. Click the Build Mailing List button.
6. This will display the Selection Criteria window.
3.3.8.1 Selection Criteria Window

The Selection Criteria window is used to define the criteria for choosing particular people for a mailing list. People can be selected based on a variety of topics (Last Name, First Name, City, State, ZipCode, Sex, birthdate, keywords). Up to four different selection conditions can be evaluated at one time. If multiple conditions are needed, they must be joined by either the AND or the OR clause.

Field The options for this drop list are the same for Criteria One through Criteria Four.
Name These items are all fields related to the personal profile information. The fields included are first name, last name, city, state, zipcode, birthdate, sex, and keyword.
Operator The options for this drop list are the same for Criteria One through Criteria Four. The meaning of each item is defined below:

= Is Equal To. (i.e. Field name is equal to Value)
<> Is Not Equal To. (i.e. Field name is not equal to Value)
< Is Less Than. (i.e. Field name is less than Value)
> Is Greater Than. (i.e. Field name is greater than Value)
>= Is Greater Than or Equal To. (i.e. Field name is greater than or equal to Value)
<=  Is Less Than or Equal To. (i.e. Field name is less than or equal to Value)

Valu The options for this field are dependent on the selection of the Field value. If State, Sex, or Keyword are the selected Field name, a drop list of allowable values is given. If Birthdate is the selected Field name, only dates may be entered (in mm/dd/yyyy format). All other Field name selections will allow the entry of any characters in this field. DO NOT put single or double quotes (or ) around letters to be evaluated.

Join The join options between each condition are the same. AND and OR conditions are mutually exclusive in this query builder. If AND is selected as the join condition between criteria one and criteria two it will be used between all other criteria also. The same rule applies for the OR condition. If NONE is selected the criteria following the condition will be cleared.

Clear When clicked, all the fields in the window are cleared.

Close This button, when clicked, will close the Selection Criteria window.

Build When pressed it builds a mailing list based on the criteria entered and the Selection List window is displayed.

See Also
Mailing Lists

3.3.8.1.1 Selection Results

This window shows the people that fit a stated criteria defined in the Selection Criteria window. It shows all the information about the person that can be used for selection criteria. Names may be listed twice in the name list, but only one will be placed in the mailing list.

Name List Box Shows the names of the selected people
Profile Info  Display only fields showing city, state, zipcode, birthday, and sex of the selected name in the list box.
Keyword List Box Display only fields showing any keywords associated with the selected name in the name list box.
Add to List Button When clicked, this will add the people in the name list to the mailing list and then close this window. If a name is listed twice in the name list they will be placed in the mailing list only once.

Return Button When clicked, this will close this window and return to the selection window without adding names to the mailing list.

See Also
Selection Criteria Window

© 1994 - 2011 by TurboSystemsCo, LLC
3.3.9 Keywords

The program includes a user defined keyword list. Keywords allows you to define a list of criteria (i.e. products, interests, customer types, etc.) that can be assigned to individuals. More than one keyword can be assigned to an individual for flexibility.

See Also

Keyword List
Keyword Form

3.3.9.1 Keyword List

This window displays all the possible keywords to categorize people.

Keyword List Box This box contains the list of keywords used to categorize people for mail lists.
Keywords must be inserted here in order to show when assigning a particular keyword to an person

Add Button Click to add a new keyword. Displays the Keyword Form
Edit Button Edits the highlighted keyword. Displays the Keyword Form.
Delete Button Deletes the highlighted keyword. Note you cannot delete any keywords that are assigned to a person. You must remove the keywords association from all people prior to deleting.

Close Button This button, when clicked, will close the window.

See Also
Keyword Form

Keywords

3.3.9.1.1 Keyword Form

This window displays the information for one keyword. It also has a listing of all people who have this keyword in their personal profile.

Description The name of the keyword. This description will be shown on lookup lists and reports.

People List Box Displays people who have this keyword in their personal profile. New people can be added to this list and existing people can be removed from the list.

Add Button This button calls a pick list of peoples names to be added to the people list box.
Delete Button This button will delete the highlighted person from the people list associated with
Button  this keyword. It does not delete the person from the file, only their reference to this keyword.

OK  When this button is clicked, any information changed or added about the keyword is written to the file on disk. The window is then closed.

Cancel  When this button is clicked, any information changed or added about the keyword is not kept, the window is closed without saving to the file.

See Also
- Keywords
- Keyword List
- Select a Person

This window displays all the people with a defined personal profile (name and address information).

People  This box contains all the people eligible for a mail lists. A person can be selected by using the keyboard or by selecting with the mouse. A person may be located by typing the letters of the persons last name.
Select  Click this button to choose the highlighted person and add them to the calling form.

Close  This button, when clicked, will close the window.

See Also
Keyword Form

3.3.10 Name Prefix List
Use this option to Add, Edit or Delete a name prefix.

Example name prefixes:
Mr
Mrs
Miss
Dr
Capt

3.3.11 Name Suffix List
Use this option to Add, Edit or Delete a name suffix.

Example name suffixes:
Jr
Sr
Phd
III
IV

3.3.12 State List
Use this option to Add, Edit or Delete states or provinces.

3.3.13 Language List
Use this option to Add, Edit or Delete Languages.

Examples:

English
Spanish
French
German

The language selected for a person is used to determine the language to use for the letter printed.

3.3.14 Country List
Used to Add, Edit or Delete Countries.

Examples:
3.4 Performing Actions on Addresses

3.4.1 Sending Email

TSC Free Address Book can send email using your default e-mail system

Click the Email Button if enabled to send an email to the highlighted person on a browse list or the person you may be editing.

3.4.2 Get Driving Directions and Map

TSC Free Address Book can bring up a map of the highlighted or edited address by clicking the MapQuest Button. The MapQuest Button activates your web browser and displays a map of the address where you can obtain driving directions to the address.

3.4.3 Get Address Information

TSC Free Address Book can obtain information about the highlighted or edited address by clicking the Address Info Button.

Click the Address Info Button which will open your web browser and provide you with the following information about the address if available:

- Zip + 4
- Latitude
- Longitude
- Time Zone
- Congressional Representative
- Census tract
- Census block
- County
- School District
- Delivery Post Office
...much more

Information provided by http://melissadata.com

3.4.4 Visit a Web Site

If the person or organization highlighted or edited has a website entered in the database, click the Website Button to open your web browser and visit the website.
3.5 Letters

3.5.1 About Letters

TSC Free Address Book allows you to create an unlimited number of letters that can be printed to an individual, a mailing list or to everyone in the database. You can also print a letter in different languages based on the language of the contact. To add a letter to be printed in another language, an English letter must be entered first, then another letter must be entered with the same category, same letter name and a different Language. In the window below, the English version of Test1 would be printed for every contact in the database who’s language was listed as English, the Spanish version of the Test1 letter would print for all contacts who’s language was listed as English. If no language for a contact is entered, the English version of the letter will always print.

The language function is very useful if you have contacts that you need to provide letters in different languages. The program does not translate the letters and you must provide the language translation.

To access the letter list select List/List of Letters or click button on the toolbar and the Letters File window below is displayed:

![Letters File window](image)

This window displays all the letters in the file. By default the letters are displayed sorted by Category, then by Letter Name. To display the letters displayed sorted by letter name only, click the By Letter Name tab.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Add a new letter to the list</td>
</tr>
<tr>
<td>Edit</td>
<td>Click to make changes to the highlighted letter</td>
</tr>
<tr>
<td>Delete</td>
<td>Click to delete the highlighted letter</td>
</tr>
</tbody>
</table>
3.5.1.1 Add a New Letter

When the Add or Edit button on the Letters List is clicked the window below is displayed. Add allows you to add a new letter while Edit allows to make changes to an existing letter.

**Field** | **Description**
--- | ---
Category | Select a letter category from the drop down list such as Personal or Customer etc. You can add a new category by typing in a new category name or selecting [Lists>Category](#) from the main menu.
Name | Enter a name to identify the letter.
Language | Select a language for the letter from the drop down list. You can add a new language by typing a new language or selecting [Lists>Language](#) from the main menu.
Top Margin | Use this field to set the top margin for the letter.
Left Margin | Use this field to set the left margin for the letter.
Right Margin | Use this field to set the right margin for the letter.
Test Width Font
Display on field. shows the width of the printed letter. Select the font you want to use for the letter. In this release you cannot select a font for an individual word. The font you select is used for the entire letter.

Letter Body
This is where you type your letter. Letters are limited to 8000 characters.
Available! You can insert information from the database into the body of the letter. Highlight the field e Fields you want and press the Insert Selected Field Button.

Insert Field OK
Highlight one of the available fields and click this button to insert the field into the body of the letter. Saves the entered information to the Letter List and closes the window.

Cancel
Closes the window without saving any information.

Help
Displays the Help Window

ABC
Spell checks the letter.

To place a field into the letter, place your cursor at the spot in the letter where you want the field to go. Then highlight the field you want in the available fields box and the click the Insert Selected Field button.

The Persons Full Name field, includes the persons name prefix, first name, middle name, last name and name suffix. Information from all the fields are displayed spaced correctly.

The CityStateZip field includes the city, state and zip code. The information from the three fields are spaced and formatted correctly in the letter.

3.5.1.2 Add a New Category

From the Main Menu select File>Category. Categories are only used in Letters. Use this to Add, Edit or Delete a letter Category.

Examples:

Personal
Employee
Customer

3.6 Print

To Print Reports, Letters and Labels select the following from the main menu:

Print

You can print Summary Reports, Letters, and Labels.

Reports are listed to the screen for viewing, but can be printed to the printer, html, pdf, text or xml, by clicking one of the buttons on the Report Destination window below:
The toolbar below is displayed on the print preview.

**Zooming & Scrolling**

- **Left Mouse** Zoom IN
- **Right Mouse** Zoom OUT
- **Gray +** Zoom IN
- **Gray -** Zoom OUT

- **Up Arrow** Scroll toward top of page
- **Down Arrow** Scroll toward bottom of page
- **Left Arrow** Scroll toward left side of page
- **Right Arrow** Scroll toward right side of page

**Paging**

Buttons, or keys listed below, can be used to navigate during report viewing.

- **HOME** or **Ctrl+PgUp** First page (or group)
- **PgUp** Previous page (or group)
Getting Started with TSC Free Address Book

PgDn  Next page (or group)
END  or Ctrl+PgDn  Last page (or group)
G  Go to Page by Number

Searching  
Buttons, or keys listed below, are used to perform text searches within your report.

F  Set text search options
F3  Find next occurrence
Shift+F3  Find previous occurrence

Marking  
Buttons, or keys listed below, allow pages to be marked for processing.

R  Mark a range of pages
U  Unmark all pages
A  Mark all pages
Spacebar  Mark/Unmark current page

Delete  
Button, or Delete, will delete the current page.

Please note that this cannot be undone. Once a page is deleted it cannot be retrieved.

Setup  
Button, or V, opens the viewer setup window.

Page Size  
Button, or keys listed below, are available during single page view to resize pages within the viewer frame.

W  Fit page into width of viewer
H  Fit page into height of viewer

 Thumbnails  
Buttons, or keys listed below, are used to change page views.
1 single page view
2 2 thumbnails, again for single page view
4 4 thumbnails, again for single page view
6 6 thumbnails, again for single page view
T toggle between all optional views

Printing Button, or Enter, will open the report output window.

Exit Button, or Esc, will close the report and exit.

3.6.1 Summary Reports
Displays information on all people in the database, unless filtered using the Query Wizard. Select Print>Summary Reports from the Main Menu. Reports can be printed to the screen for preview, printer, pdf, html, xml and text.

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>People by State/City</td>
<td>Creates a report of all people sorted by State and City.</td>
</tr>
<tr>
<td>People by Alphabetical Order</td>
<td>Creates a report of all people ordered alphabetically.</td>
</tr>
<tr>
<td>People by Keyword</td>
<td>Creates a report of all available keywords and those people who are associated with that keyword</td>
</tr>
<tr>
<td>Mailing List Summary</td>
<td>Creates a report of all the mailing list including mailing list name, description and the people on each list.</td>
</tr>
</tbody>
</table>

When any of the above reports are selected the window below is displayed which gives you the option to filter the report.
Query Option | Description
---|---
Select a Previously Saved Query | If you previously created a query for this report and saved it, use this option to select the query.
Create a New Query | If you want to filter the items printed in the report, click this button the create a new query.
Do not Apply a Query | If you want to print all the people in the report, click this button.
Cancel without Continuing | If you decide you don't want to print the report, click this button to cancel.

### 3.6.2 Labels

Select Print>Labels from the main menu. You are then presented with three label report options. See list below:

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Labels by List</td>
<td>Allow you to print labels for members of a particular list, for example birthday list.</td>
</tr>
<tr>
<td>Labels to All</td>
<td>Prints labels for all people in the database.</td>
</tr>
<tr>
<td>Labels to an Individual</td>
<td>Print labels for one individual.</td>
</tr>
</tbody>
</table>

Labels can be printed to the screen for preview, printer, pdf, html, xml and text.

#### 3.6.2.1 Labels by List

When you select the labels by list report the window below is displayed to allow you to select the report options. Use this report to print labels for members of a particular mailing list. Select the following from the main menu to print:

Print>Labels by List
Select a Mailing List - click this button to select the list you want to print labels for.

Select Label Type to Print - click this button to select the label type you want to print.

Customer Status - gives you the option to print to active people, in-active people or both active and in-active.

Query/Filter the Mail List - if checked, will activate the Query Wizard where you can enter a new filter or select an existing filter.

Go - prints the labels using the selected options.

Cancel - closes the window without printing the labels.

See Also
Print

3.6.2.2 Labels to All

Use this option to print to labels to all people in the database. Select the following from the main menu to print:

Print>Labels>Labels to All

After selection you are prompted to select the label type to to use to print the list.
After selecting the label type you are given the option to filter the list by use of the Query Wizard.

<table>
<thead>
<tr>
<th>Query Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a Previously Saved Query</td>
<td>If you previously created a query for this report and saved it, use this option to select the query.</td>
</tr>
<tr>
<td>Create a New Query</td>
<td>If you want to filter the items printed in the report, click this button the create a new query.</td>
</tr>
<tr>
<td>Do Not Apply a Query</td>
<td>If you want to print all the people in the report, click this button.</td>
</tr>
<tr>
<td>Cancel without Continuing</td>
<td>If you decide you don't want to print the report, click this button to cancel.</td>
</tr>
</tbody>
</table>

See Also

Print

3.6.2.3 Labels to an Individual

When you select the labels to an individual report the window below is displayed to allow you to select the report options. Use this report to print a label for one or more individuals in the database. Select the following from the main menu to print:

Print>Labels to an Individual.
When the Select People Button is pressed the window below is displayed to allow you to select the individual(s) you want to print labels for.
On the above screen, the individuals, Bobbet, Billy C and Turner, Lemuel D are tagged to print labels.

You can tag an individual by double clicking an highlighted record or by using the tag button.

Click the Done button when you are finished selecting individuals.

Next select the label type you want to print and the labels will be printed for the individuals.

See Also
Print

3.6.3 Letters

Select Print>Letters from the main menu. You are then presented with three letter report options. See list below:

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Letters by List</td>
<td>Allows you to print letters to members of a particular list, for example birthday list.</td>
</tr>
<tr>
<td>Letters to All</td>
<td>Prints letters for all people in the database.</td>
</tr>
</tbody>
</table>
Letters to Individual

Print letters for one individual.

Letters can be printed to the screen for preview, printer, pdf, html, xml and text.

3.6.3.1 Letters by List

When you select the letters by list report the window below is displayed to allow you to select the report options. Use this report to print letters for members of a particular mailing list. Select the following from the main menu to print:

Print>Letters by List

Select a Mailing List - click this button to select the list you want to print labels for.

Select Letter to Print - click this button to select the letter type you want to print.

Customer Status - gives you the option to print to active people, in-active people or both active and in-active.

Query/Filter the Mail List - if checked, will activate the Query Wizard where you can enter a new filter or select an existing filter.

Go - prints the letters using the selected options.

Cancel - closes the window without printing the letters.

See Also

Print
3.6.3.2 Letters to All

Use this option to print to letters to all people in the database. Select the following from the main menu to print:

Print>Leters>Leters to All

The window below is displayed:

Select a Mailing List - click this button to select the list you want to print labels for.

Select Letter to Print - click this button to select the letter type you want to print.

Query/Filter the Mail List - if checked, will activate the Query Wizard where you can enter a new filter or select an existing filter.

Go - prints the letters using the selected options.

Cancel - closes the window without printing the letters.

See Also

Print
3.6.3.3 Letters to Individual

When you select the letters to an individual report the window below is displayed to allow you to select the report options. Use this report to print a letters for one or more individuals in the database. Select the following from the main menu to print:

Print>Letters to an Individual.

When the Select People button is selected the window below is displayed to allow you to select the individual(s) you want to print letters for.
On the above screen, the individuals, Bobbet, Billy C and Turner, Lemuel D are tagged to print letters.

You can tag an individual by double clicking an highlighted record or by using the tag button.

Click the **Done** button when you are finished selecting individuals.

Next select the [letter type](#) you want to print and the labels will be printed for the individuals.

**See Also**

- [Print](#)
Top Level Intro

This page is printed before a new top-level chapter starts

Part IV
4 Using the Query Wizard

The Query Wizard allows you to create and save your own queries in plain English. The Query Wizard interface is very easy to use and guides you through building simple or complex queries step by step. You can use the queries to view the selected data in the browse window or to print to a report. You have the ability to view and or print just the items you want.

Select from the following options to jump to a topic...

Components of a Query
Field Selection
Operator Selection
Value Entry
Query Review
Selecting and Resetting a Query
Saved Query Selection Dialog

Query Wizard - Copyright 1995-1999 Nice Touch Solutions, Inc.

4.1 Components of a Query

By definition, a query is much the same as a question. In the case of database queries, a user is asking their database a question. Computer programs use languages that we, as humans do not ordinarily use in our daily lives. In this case Query Wizard acts as our interpreter. The Query Wizard interpreter allows questions to be asked in a language that both the user and their database will understand.

Each Query may consist of one or more questions, logically connected. In order to complete a valid "computer" question Query Wizard must collect three components of information: Field, Operator and Value. Given these three components, Query Wizard will construct a meaningful question.

Field

The field is generally representative of information contained within in the database. The field is therefore considered the subject of the question or what you would like to learn about. A few examples of fields would be Title, Author or Subject.

Operator

The Operator represents the comparison to be made between the Field and Value. Due to the nature of the value, operator selections for numbers are limited when compared to those for text. For example the most common numeric operators are Greater Than, Less Than or Equal To. The nature of text operators allow for such comparisons as Contains and Begins With. The Operation Selection guide discusses these issues in greater detail.
Value

The Value will be compared (via the operator) to the field in your database. The value entry is the way you wish to describe the subject (field) of the question. In essence the value describes the trait the field should have (or not have). Query Wizard offers many useful features to assist the user with their value consideration.

Query Wizard - Copyright 1995-1999 Nice Touch Solutions, Inc.

4.2 Query Wizard Field Selection

This dialog is the first of three steps and is composed of a list of fields available to be queried.

To select a field, simply highlight the desired field and press the Next button.

Query Wizard - Copyright 1995-1999 Nice Touch Solutions, Inc.
4.3 Query Wizard Operation Selection

This dialog is the second of three steps and is composed of those operators relevant to the selected field. The Operator represents the comparison to be made between the Field and Value. Due to the nature of the value, operator selections for numbers are limited when compared to those for text.

To select an operator, simply highlight the desired operator and press the Next button.

Common Operators (both numeric and text)

**Equal To**
The field and the value must have the same value.

**Greater Than**
The field must be greater than the value.

**Less Than**
The field must be less than the value.

Text Operators

**Begins With**
The field must begin with the value.

**Contains**
The field must contain the value at any position within the text.
4.4 Query Wizard Value Entry

This dialog is the last step and is used to collect the value component of the query. This value will be compared (via the operator) to the field in your database. In essence the value describes the trait the field should have (or not have).

When the value entry has been completed simply press the Next button continue.

Case Sensitivity and Absolute Power

Query Wizard offers many useful features to assist the user with their value consideration. Two examples are Case Sensitivity and Absolute Value. Case sensitivity may be invoked if the selected field is a string while absolute values may be compared when the field is numeric.

Types of Values (constant, another field, expression)

- Constant Value

This option allows the user to type the value directly into Query Wizard. As illustrated above, this is the default option and would normally be used with most queries.

- Another Field

This option is quite useful for comparing two existing database elements. This selection may be made from a list of fields identical to those in the first Query Wizard step. The actual value of this field will be used for comparison to the field selected in step one.
Expression

This is an advanced option which requires a limited knowledge of the underlying computer language. Although more complex, when used in the appropriate context this can be a very powerful feature. This expression should return a value to be used for comparison to the field selected in step one.
4.5 Query Wizard - Query Review

The Query Wizard review dialog allows you to review, modify or delete from the existing query. Query elements (each question) may be manipulated by first highlighting the desired element then pressing the respective button to perform the desired action.

To create a query with more than one question within the same query, simply press the AND or the OR button. This will guide the user to step one of the Query Wizard. Upon completing the three wizard steps, a new sentence will appear in the review list as illustrated above. When formulating a compound query, please ensure that you do not mix an AND with an OR. In other words use all ANDs or all ORs but never an AND and OR together in the same query.

When the query is satisfactorily completed, press the finish button to apply the newly formulated query.

Query Wizard - Copyright 1995-1999 Nice Touch Solutions, Inc.
4.6 Saved Query Window

All saved queries are displayed on this dialog in alphabetic order. To select a query simply highlight a specific description then press the button representative with the action to be performed.

Select
This button will select the highlighted query for use with the current operation.

Insert
This button will allow the creation of a new query.

Change
This button will select the highlighted query for modification. Upon completion of the modification the query may be saved with a new description (as a new copy) or you may overwrite the existing query. When the query has been successfully saved it will be applied for use in the current operation.

Delete
This button will permanently delete the currently highlighted query.

AND Join / OR Join
While only available when a query is currently active in the browse, these options will create a compound query by joining the highlighted query with the currently active query. When creating a new query the Compound Query Dialog will prompt the user for the same options.
4.7 Selecting and Re-Setting

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query</td>
<td>Select this button to create a query</td>
</tr>
<tr>
<td>Reset</td>
<td>Select this button to in-activate a query and display all records</td>
</tr>
</tbody>
</table>

4.8 Case Sensitivity

- [ ] Compare Using Case Sensitive Matching

When enabling case sensitive matching we are telling the computer that we DO CARE and that it DOES matter if the text stored in our database is in UPPPER or LOWER case. Truth of the matter is, we usually don't care and would normally leave this option unchecked.

- **When Case Sensitive Matching is Enabled (checked)**
  - Smith and SMITH are not the same.

- **When Case Sensitive Matching is Not Enabled (unchecked)**
  - Smith and SMITH are considered to be the same.

4.9 Absolute Value

Absolute value is always the positive value of a number. When enabling comparisons using absolute value, we are telling the database that we DO NOT care and it DOES NOT matter if the field's value is negative or positive. Truth of the matter is, we usually do care and would normally leave this option unchecked.

- **When Compare Using Absolute Value is Enabled (checked)**
  - -100 is considered to be 100.

- **When Compare Using Absolute Value is Not Enabled (unchecked)**
  - -100 is considered to be -100 (as it normally would be)
Top Level Intro

This page is printed before a new top-level chapter starts

Part V
5 Using the View Wizard

View Wizard allows you to...

- Use an intuitive wizard-driven interface to quickly create and save an unlimited number of custom list box formats with optional sort orders.

- Saved "views" may be dynamically selected at any time.

- Select from an existing sort or create ad-hoc sorting on up to four levels.

- Quickly hide an existing column or show a hidden column.

- Drag and drop columns for lateral movement.

- Use column headings to quickly create a single field sort order (ascending or descending).

Select from the Following Options to Jump to a Topic...

View Layout Selection Dialog [Define View Button]

The dialog allows you to create, modify, delete or select a view for execution.

View Column Layout [Modify View Button]

This dialog is the first of two steps and is composed of the fields available for the view detail. From this dialog, the user selects the fields they wish to appear in the view.

View Sort Order

This dialog is the second of two steps and is composed of three options which allow the user to determine the view's sort order. The user may use the default sort order, choose an existing (predefined) key or create their own custom sort order.

Managing the View from Browse Procedure

Based on the options provided in your application, use the following general guidelines for managing your view's layout directly in the browse procedure window (without invoking the wizard).

5.1 View Layout Selection

This dialog is presented when the "Define Views" option has been invoked. As you highlight a specific view, details pertaining to the view's layout are displayed on the lower portion of the dialog.
New...

Allows for the creation of a new view layout. At times, the Copy command may be a better alternative.

Copy...

Copies the highlighted view then asks for a new name.

Modify...

Allows for the modification of the highlighted view's layout.

Rename...

Allows for the modification of the highlighted view’s name.

Delete

Deletes the highlighted view.

Select

Selects the highlighted view for execution.

5.2 View Column Layout

The Column Layout dialog is the first of two potential steps when creating or modifying a view layout. From this dialog you will select the columns to appear in the view and their layout from left to right.
The list on the left represents those fields (columns) which are available while the list on the right displays those fields which have been selected for the view. The text displayed in these lists will become the column heading(s) in the view. Selected fields will be displayed from left to right as they appear from top to bottom. When the Column Layout has been completed press the Next button to continue.

You may design the view layout using the following techniques.

**To add fields to the view...**

- Highlight a field in the left list and press the Add -> button to move the field from the available field list to the selected field list.

- Double-click any field in the available field list to move the field to the selected field list.

- Drag-and-drop any field from the available field list to the selected field list.

**To remove fields from the view...**

- Highlight a field in the right list and press the <- Remove button to move the field from the selected field list to the available field list.

- Double-click any field in the selected field list to move the field to the available field list.

- Drag-and-drop any field from the selected field list to the available field list.

**To change the column layout...**

- Selected fields will be printed from left to right as they appear from top to bottom in the selected field
list.

- Click [Up arrow button] to move a column up (or to the left in the view).
- Click [Down arrow button] to move a column down (or to the right in the view).

### 5.3 View Sort Order

The Sort Order dialog is the second of two potential steps when creating or modifying a view layout. In some applications, this dialog may not be present.

**Modify View Format (MyView)**

**Select a Sort Order for the View**

You may select from a predefined sort order or create a custom sort order of your own. Custom sort orders should only be used when accessing a limited amount of data or when defining the sort order for a report or other output.

- Use the Default Sort Order
- Select a Predefined Sort Order (fastest)
- Define Your Own Custom Sort Order (slowest)

**Default Sort Order**

This option uses the default sort order.

**Predefined Sort Order**

This option will provide a list of sort orders that have been pre-defined by the developer of this application. Pre-defined sort orders are usually faster than custom sort orders defined with the next option.

**Custom Sort Order**

This option allows you to display the view in any desired order. When enabled, this option will allow you to invoke the View Wizard's ad-hoc sort designer. The sort designer will allow you to create up to three sort levels. Each level may be ascending or descending and the entire sort may be case sensitive or insensitive.
NOTE: When using Custom Sort Orders this application will normally attempt to optimize the performance of the user defined sort. However, the sort processing can potentially be time consuming when large amounts of data need to be sorted for your report.

5.4 Manage the View

Save and Restore Settings

When leaving the window your personal settings for the list box will be saved for you automatically. These settings will then be recalled and used the next time the window is instantiated.

Drag and Drop Column Movement

This setting allows you to move columns (left or right) using drag and drop. To drag and drop a column simply point to the desired column, click and hold the left mouse button then drag the column to the desired "new" position.

"Smart" Column Resizing

This allows you to double-click on the column resize line to automatically adjust the column width to the widest area occupied by the displayed column contents.

Column Heading Popup (Context) Menu

This option allows you to retrieve a context menu by right-clicking on the list box column heading. This context menus allows you to Hide the selected column or Show a currently hidden column.

To hide a specific column simply right-click on the desired column and select the "Hide Column" menu option. To show a hidden column simply click on any column heading, select "Show Column..." then choose the desired column.

Dynamic Sort Capabilities

View Wizard will allow the end-user to modify the browse's runtime sort order. View Wizard provides several dynamic sorting options to the end user.

The end user will be allowed to:

1. Select the default sort order
2. Select from a list of existing keys
3. Build an ad-hoc dynamic sort order
4. Click on list box column headings to determine the sort field (when enabled)

Dynamic Sorting Via Column Headings

This option will provide menu options for Ascending and Descending sort selection from the column heading context sensitive popup menu. To invoke a sort on a specific column simply right-click on the desired column and select the "Sort..." menu option.

Sheet Tab to Invoke Dynamic Sort

Often times developers use sheet tabs to control the sort order for their browse. This option will
create an additional tab (on the selected sheet control) for the dynamic sort. This helps improve the "perceived" performance on slower dynamic orders because the end user can decide when to invoke the sort.
Top Level Intro

This page is printed before a new top-level chapter starts
6 Label Types

6.1 Label Types

The window below is used to select the type of label to print and also can be used to add new label types or edit the existing label type.

Use the screen below to add or edit an existing label. Here you can change the label font and style (bold, italic, etc).
Top Level Intro

This page is printed before a new top-level chapter starts.
7 Import

TSC Free Address Book allows you to import data into the system stored in dBase III/IV, Delimited ASCII, and Excel. Click on the links below for instructions on how to import data in the various formats: Also you can export data in various formats.

dBase III/IV
Delimited ASCII
Excel

7.1 dBase Import

Perform the following steps to import data stored in dBase III or dBase IV format into Book Librarian Plus.

Warning: Create a backup of your database prior to importing data, so if the import is not correct, you can restore data back to its original status prior to trying the import again.

1. From the TSC Free Address Book main menu select Files>Import Data> dbase Files. This starts the import process.

2. You will see a warning to ensure that no one else is using the program before continuing. If you purchased the single user version of TSC Free Address Book just press the continue button. If you have the 5 or 10 user version ensure no one else is using the program prior to continuing with the import.

3. Next you will see the source file options (Step 1) window below:
4. Use the file lookup button to select the dBase file you want to import. dBase files end with the extension dbf. You have the option to select the number of records you want to import from the source file. Leave the number at 0 to import all the records in the source file. Click the Next Step button to display the Step 2 window (map source fields) window seen below.
5. Click the **First** button to read in the first record in the source file along with the field names. **Note:** The fields displayed in TSC Free Address Book may be different than those shown above.

6. The list box on the left contains a list of fields from the file that you want to import data from. The list box on the right will contain a list of fields in Address Librarian with Windows. Click on the field you want to import data from in the left box and “drag” it across to the TSC Free Address Book field that you want to hold the data. Repeat for each field that you want to import.

To unlink a field double click the field in the right box.

**Import Window Buttons**

**Start** - starts the import operation and adds the data to Book Librarian Plus.

**Map by Name** - press this button to automatically link fields with the same names.

**Save** - After you have linked up the fields to import, you can click the button to save the setup so if you wish to import data from the same file again, you won't have to re-link the fields, just press the **Retrieve** button.

**Retrieve** - loads the previously saved import information.

**Cancel** - closes the import window.

### 7.2 Delimited ASCII Import

Perform the following steps to import data stored in delimited ASCII format into TSC Free Address Book. The program can import files delimited by commas, tabs, semicolons and pipes.

**Warning:** Create a backup of your database prior to importing data, so if the import is not correct, you can restore data back to its original status prior to trying the import again.

1. From the TSC Free Address Book main menu select File>Import>ASCII Delimited Files. This starts the import export program.

2. You will see a warning to ensure that no one else is using the program before continuing. If you purchased the single user version of TSC Free Address Book just press the continue button. If you have the 5,10 or 25 user version ensure no one else is using the program prior to continuing with the import.

3. You will see the source file options (Step 1) window below:
4. Use the file lookup button to select the ASCII file you want to import. You have the option to select the number of records you want to import from the source file. Leave the number at 0 to import all the records in the source file.

5. If you do not know how the fields are delimited click the view file button to view the file, so you can determine the what type of field delimiter that is used and also the format of any dates used in the file, also you can see if double quotation marks are used.

**NOTE1:** You can view the file to see if double quotation marks are used to separate the fields, if they are check the double quotes checkbox.

**NOTE2:** Some ASCII fields store record layout information in the first record instead of data. If this is the case (you can tell by viewing the file) check the skip first record checkbox.

**NOTE3:** Most ASCII records are separated by Carriage Return and Line Feed. If the records are just separated by a Carriage Return, select the end of record is just a carriage return option.

Click the Next Step button to display the Step 2 window (map source fields) window seen below.
6. Click the **First** button to load the first record from the source file. If field names are displayed you should check the skip record option on the first page. If the source file does not contain field names in the first record, data items will be displayed in the list on the left. If this is the case, it will be difficult to map the fields correctly unless you have file specifications for the source data.

7. The list box on the left contains a list of fields from the file that you want to import data from. The list box on the right contains a list of fields in TSC Free Address Book. Click on the field you want to import data from in the left box and "drag" it across to the TSC Free Address Book field that you want to hold the data. Repeat for each field that you want to import.

To unlink a field double click the field in the right box.

**Import Window Buttons**

**Start** - starts the import operation and adds the data to Book Librarian Plus.

**Map by Name** - press this button to automatically link fields with the same names.

**Save** - After you have linked up the fields to import, you can click the button to save the setup so if you wish to import data from the same file again, you won't have to re-link the fields, just press the Retrieve button.

**Retrieve** - loads the previously saved import information.

**Cancel** - closes the import window.
7.3 Excel Import

Perform the following steps to import data stored in Microsoft Excel format into TSC Free Address Book.

Warning: Create a backup of your database prior to importing data, so if the import is not correct, you can restore data back to its original status prior to trying the import again.

1. From the Address Librarian with Letter main menu select File>Import>Excel Files. This starts the import export program.

2. You will see a warning to ensure that no one else is using the program before continuing. If you purchased the single user version of Address Librarian with Letter just press the continue button. If you have the 5,10 or 25 user version ensure no one else is using the program prior to continuing with the import.

3. You will see the source file options (Step 1) window below:

4. Use the file lookup button to select the Excel file you want to import. Excel files end with the extension xls. You have the option to select the number of records you want to import from the source file. Leave the number at 0 to import all the records in the source file. Click the Next Step button to display the Step 2 window (map source fields) window seen below.
5. Click the **First** button to read in the first record in the source file along with the field names. Unless you are importing a file previously exported from Address Librarian with Letters the the source field names (left list) will probably be different from the TSC Free Address Book names (right list).

6. The list box on the left contains a list of fields from the file that you want to import data from. The list box on the right contains a list of fields in TSC Free Address Book. Click on the field you want to import data from in the left box and "drag" it across to the Address Librarian with Windows field that you want to hold the data. Repeat for each field that you want to import.

To unlink a field double click the field in the right box.

**Import Window Buttons**

**Start** - starts the import operation and adds the data to TSC Free Address Book.

**Map by Name** - press this button to automatically link fields with the same names.

**Save** - After you have linked up the fields to import, you can click the button to save the setup so if you wish to import data from the same file again, you won't have to re-link the fields, just press the Retrieve button.

**Retrieve** - loads the previously saved import information.

**Cancel** - closes the import window.
Top Level Intro

This page is printed before a new top-level chapter starts
8 Export

8.1 Export

1. From the TSC Free Address Book main menu select File>Export. This starts the export program. See also import data

2. Use the screen below to select your export file format and date options. Data can be exported to dBase III & IV, Delimited ASCII, FLAT ASCII, HTML and Excel formats.

![Export Options Screen]

3. Select the applicable export file format. By default the export file is saved in the application folder using the default filenames. You can change the select a different folder location by pressing the file lookup button.

4. Select the applicable date format and answer any other applicable options.

5. Click the Select Fields to Export. By default all fields are selected for export. You can change the fields to export if desired by clicking the applicable tag button.
Top Level Intro

This page is printed before a new top-level chapter starts

Part IX
9 Backup and Restore

You should backup your data on a regular schedule. This is valuable insurance, in case you lose your data for any reason you have the ability to restore your data if you maintain backups.

Before performing backup the first time, you need to setup the backup manager. Click on this link for instructions on setting up the backup manager.

Backup Data

If you have setup the backup manager to perform automatic backups you don't have to take any actions to backup your data as backups will be created automatically. If you want to perform a manual backup select File>Manuual backup from the main menu or click on the icon on the toolbar. You can run a manual backup anytime even if you have automatic backups set.

Restore Data

1. Select File>xDataBackup Manager from the main menu which displays the screen below:

2. Click the Restore Backup button which displays the screen below:
3. Highlight the backup file you want to restore and click on the **File Contents** tab. See below:

4. If you want to restore just one file, highlight the file and right click with your mouse. Select Extract this file from the popup menu.

5. To restore all files, highlight any file, right click with your mouse and select **Extract all Files**.

**NOTE:** When you select Extract this file or Extract all Files, the files are restored to the same location from which they were backed up. Normally you want to restore to the same location. If for some reason you want to restore the files to a different location, select the Extract all to a Folder menu item.
View Log Button - shows a log of all backup and restore actions.

Exit without Save - close the window and do not save any changes.

Save and Exit - close the window and save any changes made.

Backup and Restore Notes.

1. The program cannot backup data to a CD or DVD drive. If you backup your data to the default backup folder or another folder on your hard drive, you should copy the backup data using Windows File Explorer or other program to a CD or DVD or other removable storage device and store in a safe location.

2. The backup files are stored in an industry standard zip file format and the data can be extracted by any program that can read zip files such as WinZip, PkZip etc.

3. DO NOT perform a restore to see if the backup is good without taking the following precaution.

a. First copy all files ending with the extension TPS to another folder before doing a restore. If the files are corrupt on your restore disk, you can copy the TPS files back from the folder where you copied them.

9.1 Backup Setup

To setup the backup module select File->xDataBackup Manager The xDataBackup Manager screen below is displayed.

Backup Settings:
Backup Folder - If you select the "default" option your backup data will be stored in. If you select the "Other" option, you can select the location to store the backup file by typing in the location (in the Folder for backup field) or using the lookup button beside the Folder for backup field to select a location. The program cannot backup data to a CD or DVD drive.

Date format in Filename - select one of the data format options. The date format is used as part of the filename. We recommend that you do not select the "Generate unique name (for compatible with 8.3 names). More on this later.

Filename Prefix: Enter Ad

FileName delimiter: Use the default or select any from the drop down list.

Compression level: 9 is the maximum compression level (i.e. smallest backup file); 1 is no compression (i.e. the files are backed up without being compressed). Recommended level is 9.

Below is an example backup filename:

AD-111209-1208-M.zip

The naming convention is designed so you can easily identify when the backup was made (date and time) and the method use to backup the file. See explanation of the example below:

AD = TSC Free Address Book

111209 = Nov 12, 2009

1208 = 12:08 PM the time is in hours and minutes. The hours are military time (i.e. 24 hour clock). Click for 24 Hour Conversion table.

M = manual backup

B = automatic at program start-up

E = automatic at program end

DAY = automatic once a day

9.2 24 Hour Clock

Below is table to convert time from 24 hour clock to 12 hour clock:

<table>
<thead>
<tr>
<th>24 Hour 12 Hour Clock Clock</th>
</tr>
</thead>
<tbody>
<tr>
<td>12 noon 12:00</td>
</tr>
<tr>
<td>1 PM 13:00</td>
</tr>
<tr>
<td>2 PM 14:00</td>
</tr>
<tr>
<td>3 PM 15:00</td>
</tr>
<tr>
<td>4 PM 16:00</td>
</tr>
<tr>
<td>5 PM 17:00</td>
</tr>
<tr>
<td>Time</td>
</tr>
<tr>
<td>-------</td>
</tr>
<tr>
<td>6 PM</td>
</tr>
<tr>
<td>7 PM</td>
</tr>
<tr>
<td>8 PM</td>
</tr>
<tr>
<td>9 PM</td>
</tr>
<tr>
<td>10 PM</td>
</tr>
<tr>
<td>11 PM</td>
</tr>
<tr>
<td>12</td>
</tr>
<tr>
<td>Midnite</td>
</tr>
<tr>
<td>1 AM</td>
</tr>
<tr>
<td>2 AM</td>
</tr>
<tr>
<td>3 AM</td>
</tr>
<tr>
<td>4 AM</td>
</tr>
<tr>
<td>5 AM</td>
</tr>
<tr>
<td>6 AM</td>
</tr>
<tr>
<td>7 AM</td>
</tr>
<tr>
<td>8 AM</td>
</tr>
<tr>
<td>9 AM</td>
</tr>
<tr>
<td>10 AM</td>
</tr>
<tr>
<td>11 AM</td>
</tr>
</tbody>
</table>
Top Level Intro

This page is printed before a new top-level chapter starts
10 File Maintenance

10.1 File Maintenance

TSC Free Address Book uses an extremely stable file system created by Softvelocity Corporation called the "Topspeed" format. SoftVelocity created Clarion for Windows the development system used to create TSC Free Address Book. You will probably never or rarely need to use the file manager. The system is very stable and does not experience the frequent corruption of such file systems as dBASE, Paradox and others. There is no need to perform time consuming regular rebuild of indexes after entering or editing data as required by some systems.

Any file system can become corrupt and hard disks do become defective and fail. The best security against file corruption and possible data loss is to backup your files on a regular basis. See Backup/Restore for information on backing up your files.

The screen and buttons are explained below.

Tag All Select all files/tables to be for action to be performed by Build, pack, Release, Fix or Info. To select a single file/table, place the cursor on the file and click. Click again to unselect a file.

Untag All Unselects all selected files.

Build Rebuilds (re-indexes) the program index files. You may want to perform this function if you notice information not being displayed in the correct order.

Pack When you delete a record from the database, it is not physically removed from the disk. It is just marked as deleted and the system does not display it. Pack physically deletes records marked as deleted and also does a build as described above. You may want to do a "Pack" if you deleted a lot of records.

Freshen Copy contents to a new file...DO NOT use unless directed by TurboSystemsCo, LLC

Create Create any missing files...DO NOT use unless directed by TurboSystemsCo, LLC

Info Displays the number of records in the selected files and the location of the file on your computer.
Index

- A -
- Add Address 18
- Add Contact 18
- Add Letter Category 37
- Add Letters 36
- Add New Database 17
- Add People 18
- Address Information 34

- B -
- Backup 82

- C -
- Category 37
- Copy Address 25
- Copy Person 25
- Country List 33
- Create New Database 17

- D -
- Delete Address 24
- Delete Contact 24
- Delete Person 24
- Driving Directions 34

- E -
- Edit Address 22
- Edit Contact 22
- Edit Letters 36
- Edit Person 22
- Email 34
- Export 79

- F -
- File Maintenance 88

- G -
- Find Address 25
- Find Person 25

- I -
- Import 71
- Introduction 9

- K -
- Keywords 31

- L -
- Language 33
- Letter Category 37
- Letters 35
- License 11
- Locate Address 25
- Locate Person 25

- M -
- Mailing Categories 27
- Mailing List 27
- Main Menu 14

- N -
- Name Prefix 33
- Name Suffix 33
- New Database 17

- O -
- Open a Database 17
- Open Existing Database 17

- P -
- Prefix 33

- R -
- Restore 82

© 1994 - 2011 by TurboSystemsCo, LLC
- S -

Send Email   34
Shareware    11
Software License  11
State List    33
States        33
Suffix        33
Support      12

- T -

Technical Support  12
Tool Bar        16

- W -

Warranty      11
Endnotes 2... (after index)